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1. Wstęp

Student ma za zadanie zapoznać się z podstawami pracy w środowisku Unity oraz założyć niezbędne
konta użytkownika w Visual Studio Community oraz Unity Hub. Instruktarz stanowiskowy oraz
omówienie kolejnych kroków prowadzi prowadzący zajęcia.

2. Spis treści

Uwaga organizacyjna: Zajęcia mają charakter wprowadzający do Unity (Unity 6.0). Samouczek
w Unity będzie omawiany krok po kroku przez prowadzącego, który będzie tłumaczył treść z języka
angielskiego.

Przebieg ćwiczenia (instruktaż prowadzącego):

1. Utworzenie kont użytkownika w Visual Studio Community oraz Unity Hub.

2. Uruchomienie Unity Hub oraz instalacja/wybór wersji Unity 6.0 zgodnie z instrukcją prowa-
dzącego.

3. Utworzenie nowego projektu (szablon ustalony przez prowadzącego) oraz omówienie struktury
projektu.

4. Omówienie interfejsu edytora Unity: okna Scene, Game, Hierarchy, Inspector, Project, Console.

5. Przejście przez wbudowany samouczek w Unity 6.0 (krok po kroku) zgodnie z poleceniami
prowadzącego.

6. Tłumaczenie i wyjaśnianie treści samouczka (z języka angielskiego) oraz wskazanie najważniej-
szych pojęć.

7. Podsumowanie: omówienie typowych problemów początkujących (np. ustawienia projektu,
import zasobów, błędy w konsoli) i sposobów ich rozwiązywania.

3. Zadania do wykonania

Utwórz konta użytkownika w Visual Studio Community oraz Unity Hub. Następnie uruchom Unity
6.0 i przejdź przez wskazany samouczek w edytorze, wykonując kolejne kroki wraz z prowadzącym
(samouczek jest w języku angielskim i będzie na bieżąco tłumaczony). Poniżej przedstawiono skrótowo
co należy wykonać w każdym z kroków.



Wprowadzenie

W zakładce All Templates należy odszukać szablon Essential Pathway, kliknąć go i utworzyć
nowy projekt o nazwie Wprowadzenie. Po uruchomieniu projektu po prawej stronie pojawi się menu
wprowadzające z etapami od 1 do 6. W ramach tych zajęć wykonujemy wszystkie etapy z wyjątkiem
etapu 5. Poniżej podano polskie tłumaczenie poleceń w formie instrukcji dla studentów.

4. Etap 1: Editor Essentials

4..1 Explore the Editor interface

Celem tej części jest poznanie podstaw nawigacji w Unity Editor. Po wykonaniu ćwiczenia student
powinien umieć:

• otworzyć scenę z okna Project,

• wycentrować GameObject w Scene view przez dwukrotne kliknięcie go w Hierarchy,

• wyjaśnić różnicę między oknami Project i Hierarchy,

• wyjaśnić zależność między Scene view a Inspector,

• poruszać się po scenie narzędziami View i Pan,

• rozpoznać podstawowe okna domyślnego układu edytora,

• uruchamiać i zatrzymywać Play mode (Game view),

• zapisać scenę.

Okno Project

Okno Project zawiera wszystkie pliki (assets) dostępne w projekcie, niezależnie od tego, czy są
aktualnie używane w scenie. Działa podobnie do eksploratora plików i jest uporządkowane folderami.

Instrukcja:

1. Zlokalizuj suwak w prawym dolnym rogu okna Project. Jeżeli go nie widać, wybierz menu
More (...) dla okna Project i włącz Two-column layout.

2. Przeciągnij suwak maksymalnie w lewo, aby wyświetlić zasoby w postaci listy. Dzięki temu
nazwy plików nie będą obcinane.

3. W folderze Assets otwórz _Unity Essentials > Scenes, a następnie dwukrotnie kliknij
-1_Starter_Scene, aby otworzyć scenę.



Okno Hierarchy

Okno Hierarchy zawiera wszystkie GameObjects obecne w bieżącej scenie. W przeciwieństwie do
niego okno Project pokazuje wszystkie zasoby całego projektu, także te, które nie znajdują się w
aktualnej scenie.

Instrukcja:

1. W oknie Hierarchy dwukrotnie kliknij kilka obiektów GameObject i obserwuj, jak są one
centrowane w Scene view.

2. Odszukaj obiekt Boxes, rozwiń go za pomocą trójkąta i przeanalizuj obiekty podrzędne.

3. Zwróć uwagę, że obiekty są uporządkowane hierarchicznie: istnieją obiekty nadrzędne (parent)
i podrzędne (child).

4. Aby wrócić do widoku całego środowiska, dwukrotnie kliknij obiekt Ground.

Scene view

Scene view jest głównym interaktywnym oknem pracy ze sceną. Służy do manipulowania obiektami
i oglądania sceny z różnych perspektyw.

Instrukcja:

1. Ustaw kursor nad Scene view, naciśnij prawy przycisk myszy i przeciągnij. To działanie
odpowiada pracy narzędzia View.

2. Zwolnij prawy przycisk myszy i użyj klawiszy strzałek, aby poruszać się po scenie:

• Up i Down — ruch do przodu i do tyłu,

• Left i Right — przesuwanie widoku na boki.

3. Korzystając z tych technik, ustaw zbliżenie na postać robota.

4. Jeżeli zgubisz orientację w Scene view, wróć do Hierarchy i kliknij dwukrotnie dowolny
GameObject, aby go wycentrować.

Narzędzie Pan

W lewym górnym rogu Scene view znajduje się pływający pasek narzędzi. Jednym z podstawowych
narzędzi jest Pan. Nad Scene view są też dodatkowe paski narzędzi i ustawień — na razie nie należy
ich zmieniać.

Instrukcja:

1. W Hierarchy kliknij dwukrotnie Stairs, aby wycentrować schody w Scene view.

2. Wybierz narzędzie z ikoną dłoni — jest to Pan tool.



3. Przy włączonym Pan tool kliknij lewym przyciskiem myszy i przeciągnij, aby przesuwać widok
na boki.

4. Zwróć uwagę na zmieniające się odbicia nieba na materiale schodów podczas przesuwania
widoku.

Game view i Play mode

Game view pokazuje scenę tak, jak będzie ją widział użytkownik końcowy. Po wejściu w Play mode
edytor przełącza się z Scene view do Game view. Po wyjściu z trybu uruchomienia wraca do Scene
view.

Instrukcja:

1. Kliknij przycisk Play w górnej części edytora.

2. Steruj postacią robota:

• klawisze strzałek lub WASD — chodzenie,
• Spacebar — skok,
• ruch myszy — obrót widoku,
• przytrzymanie Shift — bieg,
• Esc — ponowne wyświetlenie kursora, jeśli zniknie.

3. Spróbuj wskoczyć po gwiazdkę znajdującą się na platformie na szczycie schodów.

4. Po zakończeniu testu kliknij Stop, aby wyjść z Play mode.

Uwaga: po zakończeniu testowania zawsze wychodź z Play mode. Zmiany wykonane podczas
działania gry nie są zapisywane.

Okno Inspector

Okno Inspector pokazuje szczegółowe informacje o zaznaczonym GameObject. Zawiera jego components,
czyli składniki opisujące właściwości i zachowanie obiektu.

Instrukcja:

1. Zaznacz dowolny GameObject w Hierarchy i przejrzyj jego komponenty w Inspector.

2. Dwukrotnie kliknij obiekt Star, aby wycentrować go w widoku.

3. W górnej części Inspector odszukaj wartości Position, Rotation i Scale.

4. Zmniejsz wartość X Position o 1 lub 2 jednostki, aby przesunąć gwiazdkę bliżej platformy.

5. Zmniejsz wartość Y Position o 1 lub 2 jednostki, aby obniżyć gwiazdkę.

6. Ponownie uruchom Play mode, spróbuj zebrać gwiazdkę i wyjdź z trybu uruchomienia.

Uwaga: niepożądane zmiany można cofnąć skrótem Ctrl+Z (Cmd+Z w macOS).



Zapisywanie sceny

Unity nie zapisuje sceny automatycznie. Należy regularnie zapisywać postęp pracy.

Instrukcja:

1. Aby zapisać scenę, naciśnij Ctrl+S (Cmd+S w macOS).

2. Jeżeli przy nazwie sceny w Hierarchy widoczna była gwiazdka *, po zapisaniu zniknie.

3. Alternatywnie można użyć polecenia File > Save.

4..2 Master 3D scene navigation

W tej części ćwiczenia student doskonali poruszanie się w Scene view. Po wykonaniu zadania
powinien umieć:

• kadrować obiekt skrótem F,

• poruszać się w przestrzeni 3D przy użyciu Flythrough mode,

• przybliżać i oddalać widok rolką myszy,

• wykonywać orbitowanie wokół obiektów,

• przełączać się między trybami Perspective i Isometric.

Otwarcie sceny Playground

Instrukcja:

1. W oknie Project otwórz _Unity Essentials > Scenes.

2. Dwukrotnie kliknij 1_Playground_Navigation_Scene.

Kadrowanie obiektów w Hierarchy

Instrukcja:

1. W Hierarchy odszukaj obiekt Playground_Areas.

2. Rozwiń go za pomocą trójkąta.

3. Dwukrotnie kliknij kolejno obiekty:

• 01_Swingset,

• 02_Picnic_Area,

• 03_Play_Structure,



• 04_Firepit.

4. Następnie dwukrotnie kliknij obiekt nadrzędny Playground_Areas, aby objąć kadrem wszystkie
cztery elementy jednocześnie.

Flythrough mode

Flythrough mode pozwala jednocześnie obracać widok i poruszać się po scenie. W tym trybie używa
się klawiszy:

• W — ruch do przodu,

• S — ruch do tyłu,

• A — ruch w lewo,

• D — ruch w prawo.

Instrukcja:

1. W Scene view naciśnij prawy przycisk myszy i poruszaj myszą, aby rozglądać się po scenie.

2. Nie zwalniając prawego przycisku myszy, naciskaj klawisze W, A, S, D, aby latać po scenie.

3. Obejrzyj kilka obszarów sceny.

4. Jeżeli się zgubisz, kliknij dwukrotnie Playground_Areas w Hierarchy, aby ponownie ustawić
punkt odniesienia.

Skróty klawiaturowe

Instrukcja:

1. W Project przejdź do folderu _Unity Essentials.

2. Zaznacz zasób _Shortcuts-Cheat_Sheet.

3. Przeczytaj jego zawartość w oknie Inspector.

Wprowadzenie do scavenger hunt

Celem zadania jest odnalezienie czterech ukrytych cyfr tworzących tajny kod. Poprawny kod po
wpisaniu w Play mode uruchamia pokaz fajerwerków.

Instrukcja:

1. Kliknij Play, aby wejść w Play mode.



2. W centrum Game view odszukaj pole tekstowe z napisem Enter 4-digit code....

3. Wpisz dowolny czterocyfrowy numer i zobacz, co się stanie.

4. Wyjdź z Play mode.

Szukanie pierwszej cyfry

Instrukcja:

1. Uaktywnij Flythrough mode.

2. Odszukaj ukrytą cyfrę z tyłu górnej belki huśtawki.

3. Zanotuj znalezioną cyfrę.

Kadrowanie skrótem F i zoom

Instrukcja:

1. Wybierz Move tool (drugie narzędzie na pasku Scene view).

2. W Scene view kliknij grill, a następnie naciśnij F, aby go wykadrować.

3. Naciśnij kilkukrotnie F i sprawdź, jak zmienia się stopień przybliżenia obiektu.

4. Użyj rolki myszy lub dwóch palców na touchpadzie, aby przybliżyć widok i znaleźć cyfrę ukrytą
wewnątrz grilla.

5. Zanotuj tę cyfrę.

Orbitowanie

Orbitowanie polega na obracaniu kamery wokół zaznaczonego obiektu. Jest to inna operacja niż
zwykłe rozglądanie się narzędziem View.

Instrukcja:

1. Oddal widok od grilla i ustaw scenę tak, aby patrzeć na konstrukcję placu zabaw ze zjeżdżalnią.

2. Mając nadal aktywne Move tool, kliknij konstrukcję i naciśnij F.

3. Przytrzymaj Alt (Option w macOS), następnie kliknij lewym przyciskiem myszy i przeciągnij,
aby orbitować wokół obiektu.

4. Odszukaj trzecią cyfrę na spodzie konstrukcji.

5. Zanotuj cyfrę i wróć do widoku od przodu.



Gizmos i tryb Isometric

Instrukcja:

1. Kliknij prawym przyciskiem myszy Scene view gizmo w prawym górnym rogu i włącz Show
background, aby lepiej go widzieć.

2. Kliknij obiekt paleniska firepit ustawiony między dwoma krzesłami i naciśnij F.

3. Korzystając ze stożkowych znaczników gizmo, ustaw widok dokładnie z boku.

4. Kliknij prawym przyciskiem myszy gizmo i wyłącz Perspective, aby przejść do widoku
Isometric.

5. Obracaj widok za pomocą gizmo, aż zobaczysz czwartą cyfrę.

6. Zanotuj ostatnią cyfrę.

7. Ponownie włącz Perspective.

Sprawdzenie kodu

Instrukcja:

1. Kliknij Play i wpisz odnaleziony kod do pola wejściowego.

2. Jeżeli kod jest poprawny, w centrum sceny pojawią się fajerwerki.

3. Wyjdź z Play mode klikając Stop.

4..3 Pass the Scene view flying test

W tej części należy przelecieć przez serię obręczy wokół placu zabaw, aby utrwalić nawigację w Scene
view.

Aktywacja toru lotu

Instrukcja:

1. W Hierarchy zaznacz obiekt Rings. Jest wyszarzony, ponieważ jest nieaktywny.

2. W górnej części Inspector zaznacz pole wyboru obok nazwy Rings, aby aktywować obiekt.

3. Rozwiń Rings i dwukrotnie kliknij Ring_1, aby go wykadrować.

4. Przytrzymaj Alt (Option w macOS) i orbituj za obręcz tak, aby patrzeć w kierunku następnej
obręczy, a strzałka była skierowana od Ciebie.



Metoda Frame, Orbit, Zoom

Instrukcja:

1. Przeleć przez środek obręczy, używając rolki myszy lub touchpada.

2. Po przejściu przez pierwszą obręcz powtarzaj sekwencję:

• zaznacz następną obręcz,
• naciśnij F,
• przytrzymaj Alt i orbituj za obręcz,
• przewiń widok przez środek obręczy.

Ponowny przelot w Flythrough mode

Instrukcja:

1. Spróbuj przejść cały tor jeszcze raz, tym razem tylko przy użyciu Flythrough mode (prawy
przycisk myszy + WASD).

2. Dodatkowo można używać klawiszy Q — w dół oraz E — w górę.

3. Dla utrudnienia zmierz czas przejścia i spróbuj poprawić wynik.

Dezaktywacja obręczy

Instrukcja:

1. W Hierarchy zaznacz Rings.

2. W Inspector odznacz pole wyboru, aby ukryć obręcze w Scene view.

4..4 Design a mural in the Scene view

W tej części należy zbudować własną mozaikę z elementów tangramu, korzystając z narzędzi Move i
Rotate. Student powinien umieć:

• wyjaśnić różnicę między przestrzeniami Global i Local,

• przełączać układ współrzędnych podczas pozycjonowania obiektu,

• przesuwać obiekty narzędziem Move,

• obracać obiekty narzędziem Rotate,

• przełączać narzędzia skrótami klawiaturowymi QWERTY,

• przesuwać obiekt jednocześnie wzdłuż jednej lub dwóch osi.



Przygotowanie widoku

Instrukcja:

1. W Hierarchy zaznacz obiekt Mural.

2. W Inspector aktywuj go przez zaznaczenie pola wyboru.

3. Dwukrotnie kliknij Mural, aby wykadrować jednocześnie elementy układanki i obraz referen-
cyjny.

4. Użyj stożków Scene view gizmo, aby ustawić widok z góry.

Move tool oraz Global/Local

Instrukcja:

1. Wybierz Move tool.

2. U góry Scene view otwórz listę wyboru układu współrzędnych i wybierz Local.

3. Zauważ, że kierunek osi zmienia się zależnie od orientacji wybranego elementu.

4. Przełącz na Global i porównaj działanie.

5. W tym ćwiczeniu korzystniejsze będzie używanie Global, ponieważ elementy będą przesuwane
zgodnie z osiami sceny.

Ustawienie pierwszego elementu

Instrukcja:

1. Pozostaw aktywne Move tool i Global coordinates.

2. W Scene view zaznacz duży czerwony trójkątny element po prawej stronie.

3. Przeciągnij czerwoną strzałkę osi X, aby przesunąć element do środka placu.

4. Następnie przesuń go po niebieskiej osi Z, aby ustawić właściwe położenie w przód/tył.

Obrót elementu

Instrukcja:

1. Wybierz Rotate tool.

2. Zaznacz zielony pierścień odpowiadający osi Y.

3. Obracaj obiekt przez przeciąganie myszy w linii prostej, a nie ruchem po okręgu.



4. Ustaw obrót tak, aby element pasował do wybranego wzoru mozaiki.

5. Możesz eksperymentować z innymi osiami obrotu i w razie potrzeby cofnąć zmiany skrótem
Ctrl+Z.

Skróty Q, W, E, R, T, Y

Instrukcja:

1. Ustaw kursor nad Scene view.

2. Naciśnij kolejno klawisze Q, W, E, R, T, Y i obserwuj przełączanie narzędzi.

3. Naciśnij W, aby wybrać Move tool.

4. Zaznacz kolejny duży trójkątny element i ustaw go przy użyciu czerwonej oraz niebieskiej
strzałki.

5. Naciśnij E, aby przejść do Rotate tool, i obróć element.

6. Jeżeli trzeba skorygować położenie, ponownie naciśnij W.

Isometric i przesuwanie po dwóch osiach

Instrukcja:

1. Przy aktywnym Move tool zaznacz kolejny element układanki.

2. Kliknij prawym przyciskiem myszy Scene view gizmo i wyłącz Perspective, aby przejść do
Isometric mode.

3. Odszukaj mały zielony kwadrat na przecięciu osi X i Z.

4. Chwyć ten kwadrat i przesuwaj element jednocześnie po obu osiach, jak po płaskim stole.

5. Ustaw element dokładnie w żądanym miejscu.

6. W razie potrzeby użyj Rotate tool lub klawisza E, aby obrócić element.

Dokończenie mozaiki

Kontynuuj przesuwanie i obracanie pozostałych elementów, aż mozaika zostanie ukończona. Dopilnuj,
aby każdy element był prawidłowo ustawiony i zorientowany.



Ukrycie obrazu referencyjnego

Instrukcja:

1. W Hierarchy zaznacz Tangram_Reference.

2. W Inspector odznacz pole wyboru obok nazwy obiektu, aby go ukryć.

3. Kliknij prawym przyciskiem myszy Scene view gizmo i ponownie włącz Perspective.

4. Użyj orbitowania (Alt + left-click) do obejrzenia gotowej sceny z naturalnej perspektywy.

Zapis sceny

Naciśnij Ctrl+S (Cmd+S w macOS) lub wybierz File > Save.



5. Etap 2: 3D Essentials

W tej części projektowana jest scena pokoju dziecięcego z dynamicznymi obiektami, takimi jak
odbijająca się piłka i wieża z klocków. Student ćwiczy:

• nawigację 3D,

• modyfikację obiektów,

• użycie systemu fizyki Unity,

• tworzenie prefabs,

• regulację oświetlenia,

• pracę z kamerą.

5..1 Add furniture to the kid’s room

Otwarcie pustej sceny 3D

Instrukcja:

1. W Project przejdź do _Unity Essentials > Scenes.

2. Dwukrotnie kliknij 2_KidsRoom_3D_Scene.

Dodanie pokoju z prefab

Prefab to przygotowany wcześniej zasób, który można wielokrotnie wykorzystywać w projekcie.

Instrukcja:

1. W Project przejdź do _Unity Essentials > Prefabs > Rooms.

2. Przeciągnij prefab 01_Bedroom na środek podłoża w Scene view.

3. Wykorzystaj techniki Frame, Orbit i Zoom, aby obejrzeć pusty pokój:

• F — kadrowanie,

• Alt + left-click — orbitowanie,

• rolka myszy — przybliżanie i oddalanie.



Ustawienie pokoju w początku układu współrzędnych

Każdy GameObject posiada komponent Transform, który opisuje położenie, orientację i skalę. Po-
czątek układu współrzędnych sceny to punkt (0,0,0).

Instrukcja:

1. W Hierarchy zaznacz 01_Bedroom.

2. W Inspector ustaw w komponencie Transform:

• Position X = 0,

• Position Y = 0,

• Position Z = 0.

Dodanie łóżka

Instrukcja:

1. Przejdź do _Unity Essentials > Prefabs > Bedroom.

2. Zaznaczaj kolejno prefabrykaty łóżek, aby podejrzeć je w dolnej części Inspector (Preview).

3. Przeciągnij wybrany prefab łóżka do sceny.

4. Użyj Move tool i Rotate tool, aby ustawić łóżko tyłem do lewej ściany.

Dodanie pozostałych mebli

Instrukcja:

1. Z folderu _Unity Essentials > Prefabs > Bedroom przeciągnij do sceny dodatkowe meble.

2. Rozmieść je według własnego uznania za pomocą narzędzi Move i Rotate.

3. Co najmniej dodaj dywan oraz jeszcze jeden mebel.

4. Jedną część pokoju pozostaw pustą — będzie potrzebna na wieżę z klocków.

5..2 Make a bouncy ball

Dodanie prymitywu Sphere

Unity udostępnia podstawowe bryły 3D, takie jak Sphere, Cube, Cylinder, Capsule czy Plane.

Instrukcja:



1. W Hierarchy kliknij prawym przyciskiem myszy w pustym miejscu i wybierz 3D Object >
Sphere.

2. Zmień nazwę nowego obiektu z Sphere na Ball.

Zmiana skali piłki

Instrukcja:

1. Zaznacz obiekt Ball.

2. W Inspector, w komponencie Transform, ustaw:

• Scale X = 0.25,

• Scale Y = 0.25,

• Scale Z = 0.25.

Ustawienie położenia piłki

Instrukcja:

1. Przy zaznaczonym Ball odszukaj komponent Transform.

2. Ustaw pozycję:

• X = 2,

• Y = 3,

• Z = -1.

Utworzenie materiału Ball_Mat

Materiały (Materials) odpowiadają za wygląd obiektów.

Instrukcja:

1. W Project przejdź do _Unity Essentials > Materials.

2. Utwórz folder My Materials.

3. W folderze My Materials utwórz nowy materiał przez Create > Material.

4. Nadaj mu nazwę Ball_Mat.

5. Przeciągnij materiał Ball_Mat na obiekt Ball w Scene view.



Modyfikacja właściwości materiału

Instrukcja:

1. Zaznacz materiał Ball_Mat w Project.

2. W Inspector, w sekcji Surface Inputs, zmień Base Map na wybrany kolor.

3. Dostosuj suwaki Metallic Map i Smoothness.

Dodanie komponentu Rigidbody

Komponent Rigidbody nadaje obiektowi masę i pozwala mu reagować na grawitację.

Instrukcja:

1. Uruchom Play mode i sprawdź, że bez fizyki piłka pozostaje zawieszona.

2. Wyjdź z Play mode.

3. Zaznacz Ball.

4. W Inspector kliknij Add Component, wyszukaj Rigidbody i dodaj ten komponent.

5. Ponownie uruchom Play mode i sprawdź, że piłka spada pod wpływem grawitacji.

6. Wyjdź z Play mode i zapisz scenę.

Dodanie Physics Material

Physics Material wpływa na własności fizyczne zderzeń, na przykład sprężystość odbicia.

Instrukcja:

1. W folderze My Materials utwórz Create > Physics Material.

2. Nazwij nowy zasób Ball_Physics.

3. W Inspector ustaw Bounciness = 1.

4. Przeciągnij Ball_Physics na piłkę w Scene view.

5. Uruchom Play mode i sprawdź, że piłka odbija się znacznie wyżej.

6. Wyjdź z Play mode.



Przegląd komponentów piłki

Po wykonaniu poprzednich kroków piłka zawiera między innymi:

• Transform — pozycja, obrót, skala,

• Mesh Filter — kształt siatki 3D,

• Mesh Renderer — wygląd zewnętrzny i przypisany materiał,

• Sphere Collider — granice fizyczne dla kolizji,

• Rigidbody — masa, opór i integracja z systemem fizyki.

Instrukcja:

1. Zaznacz Ball w Hierarchy.

2. Odszukaj powyższe komponenty w Inspector.

3. Sprawdź, gdzie przypisane są materiał wizualny i Physics Material.

Dodanie rampy

Instrukcja:

1. W Project przejdź do Prefabs > Shapes.

2. Przeciągnij prefab Ramp do sceny i ustaw go mniej więcej pod piłką.

3. Aby ustawić rampę dokładniej, zaznacz Ball i naciśnij F, a następnie przełącz widok na górny
za pomocą Scene view gizmo.

4. Przy użyciu Move tool ustaw rampę bezpośrednio pod piłką.

5. Przy użyciu Rotate tool obróć rampę tak, aby piłka po odbiciu potoczyła się do tylnego
prawego narożnika pokoju.

6. Uruchom Play mode i zwróć uwagę, że piłka przenika przez rampę.

7. Wyjdź z Play mode.

Dodanie Mesh Collider do rampy

Aby obiekt brał udział w kolizjach, musi mieć Collider. Dla nieregularnej rampy używamy Mesh
collider.

Instrukcja:

1. Zaznacz rampę.



2. W Inspector wybierz Add Component, wyszukaj Mesh collider i dodaj go.

3. W komponencie Mesh collider zaznacz opcję Convex.

4. Uruchom Play mode i sprawdź, że piłka poprawnie zderza się z rampą.

5. Wyjdź z Play mode i zapisz scenę.

5..3 Make a tower of prefab blocks

Utworzenie pierwszego klocka

Instrukcja:

1. W górnej części Hierarchy kliknij przycisk Add (+) i wybierz 3D Object > Cube.

2. Zmień nazwę nowego obiektu na Block.

3. W Inspector otwórz menu More (...) komponentu Transform i wybierz Reset.

Zmiana położenia i skali klocka

Instrukcja:

1. Zaznacz Block.

2. Przy użyciu Move tool ustaw klocek na drodze poruszającej się piłki.

3. Wybierz Scale tool i przeskaluj obiekt tak, aby przypominał wysoki, wąski klocek.

4. Docelowo wartości skali powinny być zbliżone do:

• X = 0.1,
• Y = 0.25,
• Z = 0.1.

5. Naciśnij F, aby sprawdzić dokładnie położenie obiektu nad podłogą.

6. Uruchom Play mode, zauważ że piłka nie przewraca klocka, a następnie wyjdź z trybu urucho-
mienia.

Dodanie Rigidbody do klocka

Instrukcja:

1. Przy zaznaczonym Block kliknij Add Component.

2. Wyszukaj i dodaj komponent Rigidbody.

3. Uruchom Play mode i sprawdź, że piłka przewraca klocek.



Zamiana klocka na prefab

Instrukcja:

1. W Project przejdź do folderu Prefabs.

2. Utwórz w nim folder My Prefabs.

3. Przeciągnij obiekt Block z Hierarchy do folderu My Prefabs.

4. Zwróć uwagę, że obiekt w Hierarchy zmienia kolor na niebieski, co oznacza, że jest instancją
prefab.

Budowa wieży z prefabów

Instrukcja:

1. W pasku Scene view znajdź przełącznik Center / Pivot i upewnij się, że aktywne jest
Center.

2. Przeciągnij kilka instancji prefabrykatu Block z Project do sceny.

3. Ustaw je tak, aby utworzyły wieżę.

4. Oglądaj konstrukcję z różnych stron, korzystając z orbitowania i Scene view gizmo.

5. Uruchom Play mode i oceń stabilność wieży.

6. Po wyjściu z trybu uruchomienia popraw położenie elementów, jeśli to konieczne.

Edycja prefab i zmniejszenie masy klocka

Instrukcja:

1. W Project odnajdź prefab Block.

2. Kliknij go dwukrotnie, aby wejść do prefab editing mode.

3. W Inspector, w komponencie Rigidbody, ustaw Mass = 0.1.

4. Aby wrócić do głównej sceny, kliknij strzałkę wstecz u góry Hierarchy.

5. Uruchom Play mode i sprawdź, że piłka łatwiej przewraca całą wieżę.



Zmiana materiału prefabrykatu Block

Instrukcja:

1. Otwórz prefab Block w prefab editing mode.

2. W komponencie Mesh Renderer odszukaj właściwość Material.

3. Kliknij Object picker (o) i wybierz materiał z listy zasobów projektu.

4. Wyjdź z trybu edycji prefabu i sprawdź, że nowy materiał został przypisany do wszystkich
instancji klocka.

Utworzenie obiektu nadrzędnego

Instrukcja:

1. W Hierarchy zaznacz wszystkie obiekty Block tworzące wieżę.

2. Kliknij prawym przyciskiem myszy i wybierz Create Empty Parent.

3. Nadaj nowemu obiektowi nazwę, na przykład Block_Tower.

4. Sprawdź, że można teraz przesuwać, obracać i skalować całą wieżę jako jeden obiekt.

Zapis całej wieży jako prefab

Instrukcja:

1. Zaznacz Block_Tower.

2. Przeciągnij go do folderu Prefabs > My Prefabs.

3. Utwórz kilka dodatkowych instancji prefabrykatu Block_Tower w scenie.

4. Uruchom Play mode i sprawdź zachowanie piłki przy zderzeniu z wieloma wieżami.

Zwiększenie masy piłki

Instrukcja:

1. Zaznacz Ball.

2. W komponencie Rigidbody zwiększ wartość Mass, aby piłka skuteczniej przewracała konstrukcję
z klocków.

3. Uruchom Play mode i obserwuj rezultat.



5..4 Adjust the lights, background, and camera angle

Ustawienie kamery

Instrukcja:

1. W Hierarchy zaznacz obiekt Camera.

2. W dolnym pasku nakładek Scene view włącz opcję Cameras, aby podejrzeć obraz z kamery.

3. Przesuwaj i obracaj kamerę oraz obserwuj zmiany w podglądzie.

4. W komponencie Camera zmień parametr Field of View, aby dobrać odpowiednie kadrowanie
sceny.

Wyrównanie kamery do aktualnego widoku

Instrukcja:

1. Użyj Flythrough mode, aby ustawić idealny widok piłki i wież z klocków.

2. Zaznacz obiekt Camera.

3. Naciśnij Ctrl+Shift+F (Cmd+Shift+F w macOS), aby wyrównać kamerę do aktualnego widoku.

4. Uruchom Play mode i sprawdź efekt.

5. W razie potrzeby skoryguj Position, Rotation lub Field of View.

6. Po ustawieniu kamery wyłącz nakładkę Cameras.

Regulacja Directional Light

Instrukcja:

1. W Hierarchy zaznacz Directional Light i wykadruj go w Scene view.

2. Obróć źródło światła, aby zmienić kierunek cieni i ogólny charakter oświetlenia.

3. W Inspector, w sekcji Emission, eksperymentuj z parametrami Color i Intensity.

Zmiana skybox

Instrukcja:

1. W Project przejdź do _Unity Essentials > Materials > Skyboxes.

2. Przeglądaj dostępne materiały skybox i oglądaj ich podgląd w Preview.



3. Przeciągnij wybrany skybox bezpośrednio na niebo w Scene view.

4. Następnie wybierz Window > Rendering > Lighting.

5. W oknie Lighting, w sekcji Scene, kliknij Generate Lighting, aby przeliczyć oświetlenie i
odbicia.

Ustawienie Play mode tint

Instrukcja:

1. Wybierz z menu głównego Edit > Preferences (w macOS: Unity > Settings).

2. W menu po lewej stronie wybierz Colors.

3. Zmień kolor Playmode tint, aby wejście w Play mode było łatwo zauważalne.

4. Uruchom Play mode i oceń, czy kolor jest wystarczająco czytelny.

5. W razie potrzeby wróć do ustawień i popraw wybór.

6. Etap 5: Zadania dodatkowe

6..1 Editor Essentials: More things to try

Poniższe aktywności są opcjonalne i mają na celu rozwinięcie umiejętności pracy w Unity oraz uspraw-
nienie projektu. Każde zadanie ma przypisany poziom trudności: Easy, Medium lub Expert.
Można wykonać jedno z nich, wszystkie albo żadne — wybór należy do studenta. :contentRefe-
rence[oaicite:2]index=2

• Easy: ukończ przelot przez obręcze, używając klawiszy Q i E (ruch w górę i w dół),

• Medium: utwórz kolejny mural,

• Expert: złóż zjeżdżalnię rurową.

6..1.1 Easy: Complete the rings flythrough using Q and E (up and down)

W trybie Flythrough oprócz podstawowych klawiszy WASD można również używać klawiszy Q i E,
aby poruszać się odpowiednio pionowo w dół i w górę. Użycie Q i E jest szczególnie pomocne w
bardziej złożonych sytuacjach nawigacyjnych w środowisku 3D. To zadanie ma poziom trudności
Easy. :contentReference[oaicite:3]index=3



Instrukcja

1. W oknie Hierarchy ponownie aktywuj obiekt Rings, aby obręcze znów pojawiły się w Scene
view.

2. Ukończ trasę przez obręcze, używając trybu Flythrough (prawy przycisk myszy oraz klawisze
WASD), a dodatkowo wykorzystaj klawisze Q i E, aby sprawdzić, czy uda się wykonać zadanie
szybciej.

3. Jeżeli poruszanie się jest zbyt szybkie, otwórz menu rozwijane camera settings w pasku
narzędzi Scene view i zmniejsz parametr Camera Speed.

6..1.2 Medium: Make another mural

Najlepszym sposobem na opanowanie pracy w Unity jest praktyka. W tym zadaniu należy dodać
kolejny mural do sceny, aby poćwiczyć użycie narzędzi Move oraz Rotate, a jednocześnie uatrakcyjnić
scenę placu zabaw. To zadanie ma poziom trudności Medium. :contentReference[oaicite:4]index=4

Instrukcja

1. W oknie Hierarchy rozwiń obiekt Mural za pomocą znacznika rozwijania (trójkąta), a na-
stępnie wybierz obiekt Puzzle_Pieces. Pozwoli to przesuwać jednocześnie wszystkie elementy
pierwszego muralu.

2. Użyj narzędzia Move, aby przesunąć pierwszy zestaw elementów lekko w lewo albo w prawo,
robiąc miejsce na dodatkowy mural.

3. Gdy obiekt Puzzle_Pieces nadal jest zaznaczony, naciśnij Ctrl+D (macOS: Cmd+D), aby
zduplikować zestaw elementów.

4. W wyniku duplikacji w oknie Hierarchy pojawi się nowy obiekt o nazwie Puzzle_Pieces (1).

5. Użyj narzędzia Move, aby przesunąć nowy zestaw elementów na bok.

6. Aktywuj obiekt Tangram_Reference i korzystaj z niego jako wzorca podczas tworzenia nowego
muralu. Po zakończeniu pracy ponownie ukryj ten obraz referencyjny.

Wskazówka Dla sprawniejszej pracy warto wykorzystać poznane wcześniej techniki:

• przejdź do górnego widoku izometrycznego, aby uzyskać najlepszą perspektywę do edycji,

• w narzędziu Move wybierz zielony kwadrat znajdujący się na przecięciu osi X i Z, aby przesuwać
elementy jednocześnie wzdłuż obu osi,

• używaj skrótów klawiaturowych W oraz E, aby szybko przełączać się między narzędziami Move i
Rotate.



6..1.3 Expert: Put together the tube slide

W oknie Hierarchy można zauważyć nieaktywny obiekt Tube_Slide. Ta rurowa zjeżdżalnia jest
podzielona na trzy części i wymaga złożenia. Zadaniem studenta jest poprawne jej zmontowanie. To
zadanie ma poziom trudności Expert. :contentReference[oaicite:5]index=5

Instrukcja

1. W oknie Hierarchy wybierz nadrzędny obiekt Tube_Slide, a następnie zaznacz pole wyboru
u góry okna Inspector, aby go aktywować.

2. Złóż zjeżdżalnię, korzystając z poniższych wskazówek:

• użyj układu współrzędnych Local zamiast Global; dzięki temu łatwiej rozpoznać, czy
dany element zjeżdżalni jest ustawiony pionowo, ponieważ lokalna zielona oś Y będzie
skierowana dokładnie do góry,

• wykorzystaj nogi konstrukcji jako wskazówkę dotyczącą wysokości ustawienia elementów
— nogi powinny lekko opierać się na podłożu,

• po zakończeniu składania użyj nadrzędnego obiektu Tube_Slide, aby przesunąć i obrócić
całą zjeżdżalnię w wybrane miejsce sceny.

Uwagi końcowe

Podczas wykonywania ćwiczenia należy regularnie zapisywać scenę skrótem Ctrl+S oraz każdorazowo
wychodzić z Play mode po zakończeniu testów. Pozwala to uniknąć utraty zmian i ułatwia kontrolę
nad postępem prac.
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